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Welcome

 

Welcome to the Authorware Working Model!

We at Macromedia are excited for you to experience Authorware 3.5—the latest version of the 
most powerful authoring environment for interactive information. Authorware has the 
capabilities you need to create just about any type of interactive application you can imagine. 
Authorware’s icon-based design makes the authoring process remarkably easy and fast. And 
Authorware is the only authoring environment enhanced for use on intranets.

The enclosed Authorware Working Model CD contains a demonstration version of Authorware 
that includes virtually all features but limits the size of your Authorware pieces. Use it to start 
exploring multimedia authoring. We’ve provided sample pieces on the CD for you to run, 
examine, and modify. We’ve also included a brief tutorial that leads you through the creation of 
an Authorware piece incorporating text, graphics, sound, animation, and an interactive Director 
movie. See for yourself how easy it is to create interactive multimedia with Authorware. 

To purchase Authorware, or to get more information, contact Macromedia. We’ve provided office 
locations and phone numbers at the end of the guide. 

Thanks for taking a look at Authorware!

David Lasner
Senior Director of Product Management 
Macromedia
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1 Introducing Authorware

 

Introducing Authorware

 

Authorware is the most powerful and complete authoring environment for creating and 
publishing interactive information. It was developed to create information-oriented applications 
that are rich in multimedia content and highly interactive. Authorware provides the tools you 
need to produce:

• Networked interactive multimedia training and educational courseware

• Human resources publications on intranets

• Reference titles on CD-ROM

• Kiosks

• Performance support and just-in-time training

• Online multimedia presentations

• Interactive magazines and catalogs

• Simulations and prototypes

from Analysas Corporation’s Exito, an intensive Spanish-
language course

from CO/OP Media’s Video Producer, an interactive 
video production lab
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Intranet delivery with Shockwave for Authorware

 

Authorware 3.5 supports Shockwave technology, a new way to package and run Authorware 
pieces over corporate, government, and educational intranets. When you prepare a piece for 
intranet delivery, the piece is compressed and divided into segments. When the piece runs, the 
segments are downloaded to the user’s computer only as they’re needed. This makes it possible to 
produce large applications—20 MB, 30 MB, and larger—that run efficiently, with hardly any 
wait for startup. 

Shockwave for Authorware is a plug-in for Netscape Navigator 2.0, available free to users. To 
compress and segment your Authorware files, you use Authorware Afterburner, also available free. 
Using this technology, you can now:

• Deliver interactive multimedia training anywhere in your company, tracking user 
information, offering online help, and exchanging information between users and the 
file server. 

• Provide a central library of interactive documents for use by employees—such things as job 
listings, benefits information, phone directories, and performance-support aids—all of 
which can be updated at any time. 

• Do virtually everything that’s possible with Authorware, but now with distribution 
over intranets with streaming graphics, sounds, and animations. 

To download the Shockwave plug-in and to view a variety of shocked files, go to Macromedia’s 
Web site, http://www.macromedia.com.

 

Icon-based interface 

 

To create an Authorware piece, you simply drag and drop icons onto a flowline that provides a 
visual outline of the structure of your piece. Using only 15 different kinds of icons, you can 
quickly assemble complex interactive applications without using a line of programming. 
Authorware has a uniquely simple object-oriented design that increases your productivity and 
makes your work easier to modify and update. 

Once you’ve developed a basic structure using icons, you can run the piece and fill in the 
content—text, graphics, sounds, digital movies—as it plays. By viewing the piece from the 
user’s perspective while you create it, you can see right away what works and doesn’t work. You 
can insert and edit content on the fly and try out different ideas as you go. Because Authorware 
handles so many mechanical details for you, you’re more free to focus on the creative part. 
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Interactivity

 

Authorware was built around the concept of interactivity. The more people interact with 
information, the more likely they are to retain it—which is critical when you’re building any 
application meant to educate, train, or inform.  

Authorware provides an array of choices for designing interactions. For example, you can have 
users click buttons, select objects, enter text, move objects on the screen, or navigate to related 
information. Even if you’re new to authoring, all the possible interactions are made simple 
through straightforward menus and dialog boxes.

To enhance your customized interactions, Authorware lets you create custom buttons, check 
boxes, and option buttons using your own graphics and sounds. Custom buttons are just as easy 
to use as the built-in standard buttons. 

 

Multimedia integration

 

Authorware makes it simple to integrate text, 2D and 3D graphics, digital and analog video, and 
sound. These elements add immediacy, realism, and impact to your pieces. Authorware can use 
most industry-standard media formats.

•

 

Graphics and text

 

—Import graphics or text files (including RTF) and apply special 
effects, including a huge selection of customizable transitions. Use the toolbox to create 
simple graphics and text. 

•

 

Sound

 

—Add sound effects, music, and voice-overs using digitized audio up to CD-quality, 
16-bit, 44kHz.  

•

 

Video

 

—Incorporate full-motion and still analog video with full control over frames 
and speed.

•

 

Digital movies

 

—Import digital video, including MPEG and interactive Macromedia 
Director movies. You can even send Lingo commands from Authorware to Director movies 
and receive information back from Director. 

 

Hypermedia and hypertext

 

Build complete hypermedia functionality into your pieces. Design your pieces to take users where 
you want—or where they want—using ten kinds of hyperlinks, including links to specific pages, 
next and previous page navigation, and the ability to click on a “history” list of previously viewed 
pages. Start with the built-in navigation schemes, and then customize and build your own to 
provide even the most intricate navigation. 
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Authorware has reinvented the lost media type—text—by not only providing custom text styles 
but also by making the process of setting up hypertext simple and quick. And if your pieces 
involve a great deal of text, you’ll appreciate Authorware’s sophisticated boolean text searching. 
For example, your users can search for pages that contain any one of three words they specify, or 
pages that contain one word and not another word. 

 

The joy of reusable content

 

Two features add tremendous efficiency to your authoring: libraries and models. 

 

Libraries

 

 let you store any media that you intend to use more than once— text, graphics, 
sound, or movies—in one place, separate from your piece. To use library content, just open the 
library and drag an icon into the file you’re working on. This links the Authorware file to the 
library icon. From then on, any changes you make to the content of a library icon—for 
example, modifying the bitmap of a logo—are reflected every place the icon is used in a piece, 
and in any other pieces linked to the library. You can store libraries on file servers so many 
different authors can use the same libraries in their pieces. Using libraries also reduces file size 
and improves performance.

 

Models

 

 are files containing icon-and-flowline structures that you can reuse. Instead of re-
creating the logic in a certain complex interaction, for example, just save it as a model. Then you 
can paste it into any piece you want, and change the text, graphics, and other media as needed. 

 

Seamless cross-platform compatibility

 

Authorware is one of the few authoring packages that lets you create and deliver interactive pieces 
equally well in Windows or on the Macintosh. You can author on either platform, and easily 
convert for runtime on the other platform. 

 

The power of variables and functions

 

Authorware’s power is not limited to its icons. Hundreds of variables and functions add new 
capabilities to your pieces. 

 

Variables

 

 let you collect, store, analyze, and display data. Authorware automatically tracks 
information such as whether users clicked in a certain area and how many correct answers they 
entered. This information—and much more—can be used for automatically branching to 
various content, and it can be stored in any standard database with Authorware ODBC drivers.
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Functions

 

 vastly extend Authorware’s capabilities, performing operations such as reading and 
writing external files and jumping to other applications. Functions and variables can work 
together for additional capabilities.

You can also create custom variables and custom functions to meet your own needs. 

 

Extensible architecture

 

When you need to add unique capabilities, you can call Windows Dynamic Link Libraries (DLLs), 
Macintosh External Commands (XCMDs) and External Functions (XFCNs), and Macromedia 
transition Xtras. Authorware’s expanded use of open architecture standards also includes drivers 
for Open Database Connectivity (ODBC)—with models to help you get started. In Windows, 
Authorware also supports Dynamic Data Exchange (DDE) and Object Linking and Embedding 
2.0 (OLE). As an OLE 2.0 client, Authorware allows you to open any OLE server from within 
Authorware. This means you can deliver your pieces from floppy disks, hard disks, CD-ROMs, 
network file servers, and intranets—and jump to and from other applications and files to 
share data. 

 

Debugging made easy

 

The trace window in Authorware is a customizable debugger that lets you track the flow of events 
in a piece to quickly find problems in your design. You can move step by step through a piece to 
precisely track the logic. 

 

Delivery: pick your distribution medium

 

After you develop an Authorware piece, a single menu command creates a runtime version that 
you can distribute royalty-free to millions of users using whatever medium you want. Authorware 
automatically organizes the media layout to optimize CD-ROM performance. In addition, 
Macromedia’s unique Shockwave for Authorware technology lets you prepare a piece specifically 
for intranet distribution. 

 

New native versions for Windows 95 and NT and Power Macintosh

 

Authorware 3.5 is available in native versions for all these platforms: Windows 3.1(16-bit), 
Windows 95 and Windows NT (32-bit), and both standard Macintosh (68K) and Power 
Macintosh (Power PC). You’ll notice up to 200% faster runtime performance with Authorware 3.5 
in Windows 95 and NT and on the Power Macintosh than in Authorware 3.0. 
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In addition, if you develop an application using the Windows version of Authorware, you can now 
receive Microsoft’s official “Designed for Windows 95” logo. (Other requirements may apply, and 
you should contact Microsoft for details.) 

 

Macromedia Transition Xtras

 

Authorware 3.5 is the first Authorware release to support Xtras—extensions that add new 
capabilities to Macromedia products. Authorware 3.5 includes a number of transition Xtras, 
including the Director Transitions Xtra, which provides the entire set of over 50 transitions from 
Macromedia Director. 

With transition Xtras you can vary the duration and smoothness of transitions and choose 
whether a transition affects the entire screen or just the changing area. The expanded transitions 
in Authorware 3.5 let you dramatize information with greater impact and enhance the overall 
aesthetics of your multimedia applications. 

 

Getting a good start

 

When you purchase Authorware, you receive extra resources to help you get off to a good start as 
a multimedia author. These resources include: 

•

 

Comprehensive documentation

 

—The Authorware user manuals provide in-depth 
guidance and answers to your questions. Complete online help is available while authoring. 
A Tips and Tricks guide provides shortcuts and advanced techniques.

•

 

Authorware Smart Clips

 

—Thousands of professional-quality custom buttons, sliders, 
panels, and bullets are included. Use the browser—created in Authorware—that’s provided 
to see what’s available. Then import your favorites into Authorware, complete with 
functioning logic. 

•

 

The Authorware Portfolio

 

—Examine professional-quality models, with full 
explanations, and then paste them into your own pieces and modify them to suit your needs. 

•

 

The Tech Support Top Ten

 

—A series of Authorware files demonstrate solutions to the 
most common “how-do-I?” questions that Authorware’s technical support team has 
encountered.
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About the Authorware Working Model CD

 

The Authorware Working Model CD contains everything you need to get acquainted with 
Authorware. The CD includes:

•

 

ReadMe file

 

—installation instructions for the Working Model software, and other 
information. 

•

 

Authorware Working Model installer program

 

—The Authorware Working Model 
is a demonstration version of the Authorware software that contains nearly all Authorware 
features but can only create pieces up to 50 icons in size. The full product lets you create 
pieces as large as you want. 

•

 

Welcome folder

 

—contains files for the Authorware Welcome piece (see the “Getting 
Started” section). You can run the Welcome piece to learn the basics of using Authorware 
and get a feeling for how you might use various Authorware features in your own pieces.

•

 

QuikTour folder

 

—contains the files you need to complete the Try This! tutorial 
described in this guide.

•

 

Kiosk folder

 

—contains a complete Authorware kiosk piece you can run, examine, and 
modify. You’ll build a portion of this piece in the Try This! tutorial. 

•

 

Misc folder

 

—contains additional files you may need to run the Authorware Working 
Model, such as Video for Windows and Macintosh QuickTime. 
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Installation

 

The Authorware Working Model installation program will quickly install the Working Model and 
its associated files. For more information on installation, open the ReadMe file on the CD. 

Note: You must have Video for Windows or Macintosh QuickTime installed in order to run the 
Working Model. They’re provided in the Misc folder on the CD if you need to install them.

The table below lists the minimum hardware and software requirements for the Working Model. 
Authoring requirements for the Authorware software and the Working Model software are 
the same. 

 

Requirements Windows 3.1/ 
Windows 95 Windows NT Macintosh

 

Computer 486/25 MHz 
processor

486/33 MHz 
processor

25 MHz with a 
68030 processor 
or Power PC

System 
software

Microsoft Windows 
3.1, Windows 95

Microsoft 
Windows NT 3.5

System 7.1

Memory 8 megabytes 16 megabytes 6 megabytes 
free RAM

Display 8-bit (256-color) VGA 
graphics card

8-bit (256-color) 
VGA graphics card

640 x 480 color 
monitor

Hard Disk 
Space

15 megabytes 15 megabytes 15 megabytes

CD Drive Double speed Double Speed Double speed

Sound Sound card if you 
want to play sounds

Sound card if you 
want to play 
sounds
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Getting Started

 

As your first step in using Authorware, we recommend that you run the Welcome piece included 
on the CD. The Welcome piece introduces key concepts about how Authorware works and 
highlights key features you may want to experiment with later. It also prepares you for the second 
step we recommend: completing the Try This! tutorial, which starts on the next page. 

 

1. Start Authorware by double-clicking the Authorware icon in 

Windows Program Manager, on the Windows 95 Desktop, or on the 

Macintosh Desktop. 

 

An empty Authorware design window appears. 

 

2. Choose Open File from the File menu. 

 

In the Welcome folder on the CD, select Welcome.a3w and click OK (Windows) or select 
Welcome.a3m and click Open (Macintosh).

 

3. The Authorware file’s design window is displayed.

4. Click the Run button in the toolbar.

 

Authorware starts running the file. Follow the on-screen instructions in this piece to learn about 
Authorware features. After you’re familiar with concepts such as flowline and the icon palette, 
you’re ready to start authoring and can move to the Try This! tutorial on the next page. 
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You’re probably eager to try creating something in Authorware 
for yourself. In this tutorial, we’ll lead you through the steps in 
assembling one section of a multimedia kiosk application. 
Imagine that you’re a member of a team working on a large 
piece that will provide information about merchants, parks, 
and community activities to residents of a particular town. In 
the tutorial you’ll assemble a small portion of the application, 
using content we provide on the CD. 

Before you start, we recommend that you preview the finished 
results by opening the Complete.a3w file (Windows) or 
Complete.a3m file (Macintosh) in the QuikTour folder on the 
CD. Click the Run button in the toolbar or choose Run from 
the Try It menu. 

When you’re done viewing the complete piece, begin the 
tutorial on the next page. 

In this tutorial you’ll learn to:

• Open an Authorware file

• Recognize the basic parts of the Authorware design 
window

• Import a sound

• Link media from a library

• Apply a transition 

• Animate a graphic

• Create a framework for navigation

• Import an RTF text file

• Import a Director movie

• Import graphics

• Create hypertext (optional)

• Create an interaction with a custom button

• Paste models

• Finish the piece. 

 

Try This!
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Open an Authorware File

 

You begin by opening the Authorware file we’ve started for you. 

 

1. Start Authorware by double-clicking the 

Authorware icon in Windows Program 

Manager, on the Windows 95 Desktop, or 

on the Macintosh Desktop. 

 

An empty design window appears.

 

2. Choose Open File from the File menu. 

3. In the QuikTour folder on the CD, select the 

Start.a3w file (Windows) or Start.a3m file 

(Macintosh) and click Open. 

 

The design window for the Start file appears. The only 
item in your file so far is a display icon called Main 
Background that we’ve inserted for you. 

The illustration on the next page shows the main 
components of the Authorware screen. You may want to 
take a minute to look over these components. 

 

4. Choose Save As from the File menu. Select 

a drive on your computer and type a 

filename such as Mystart. Then click Save.

 

Authorware automatically adds the file extension .A3W 
(Windows) or .A3M (Macintosh) when the file is saved.

 

5. Click the Run button in the toolbar. 

 

When you run an Authorware file, Authorware presents it 
on the screen just as a user will see it. This lets you check 
your work in progress and make changes on the fly. Right 
now there’s only one icon in the design window, so 
Authorware opens that icon and displays its contents. 

The Main Background display icon contains a graphic 
that will be the background for the piece. Included in the 
graphic are several buttons that aren’t yet functional. 

You’re going to assemble part of the content that appears 
when users click the Shopping Areas button on the right. 

 

6. Press Control-J (Windows) or Command-J 

(Macintosh) to jump back to the design 

window. 

 

This command is the keyboard shortcut for jumping 
between the presentation window and the design window. 
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Authorware Basics 

Flowline

Design window

Icon palette

Help

Display—displays graphics and text you create or 
import using a variety of transitions.  

Motion—moves on-screen text, graphics, and digital 
movies from one point to another over a given amount of 
time or at a specified speed. Erase—removes text, graphics, animations, and 

digital movies from the screen using a variety of 
effects including Macromedia transition Xtras.Wait—pauses the application for a set duration or until 

the user clicks a button or presses a key.
Navigate—goes to the destination icon you specify. 
Provides ten different hyperlinks for navigating within 
a file.Framework—provides an easy way to create navigation 

structures. The icons you attach to the framework act 
like pages in a multimedia book. Decision—determines which path to follow based on 

author-defined controls, such as previous user 
responses.Interaction—determines which path to follow based on 

the user‘s response. Provides many response types 
including custom buttons, hot spots, and pull-down menus. Calculation—performs functions, manipulates 

variables, calls external routines, and jumps to other 
files or programs.Map—places selected icons in a new window with its 

own flowline. Use maps to organize and modularize 
your file. Digital Movie—plays back imported digital video 

sequences, including QuickTime, Video for Windows, 
MPEG, and interactive Macromedia Director movies.Sound—plays imported digitized audio such as sound 

effects, music clips, and voice-overs.
Video—plays full-motion and still analog video 
sequences using a variety of controls.

Start and Stop flags—let you run a selected part of a file 
while authoring. Place these flags on the flowline to 
indicate where to start and stop running the file.

Toolbar

Color—assigns color to selected icons to easily 
identify and organize logic, which facilitates team 
authoring.

Run button—changes to
Run from Flag (       ) when 
Start flag is placed on 
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Import a Sound

 

Authorware lets you use sounds in a variety of ways throughout 
a piece. For example, you can play a sound whenever the user 
clicks a button, or play sounds while certain items are 
appearing on the screen. 

In this section you’ll add a music clip to your piece.

 

1. Drag a sound icon from the icon palette to 

the flowline below the Main Background 

display icon. Type the title, “Travel Music.”

2. Double-click the sound icon to open it.

 

The Travel Music dialog box appears. In Windows, the 
Load Sound dialog box also appears. 

On the Macintosh, you need to click the Load button to 
open the Load Sound dialog box.

 

3. In the QuikTour folder on the CD, select the 

Travel.wav file (Windows) or Travel.aif file 

(Macintosh). Click Open. 

 

Authorware loads the sound file and returns you to the 
Travel Music dialog box. 

 

4. Click the Play button to hear the sound you 

loaded. Click the Stop button to stop the 

sound.

5. Click the list box on the left side at the top 

of the dialog box. (Wait Until Done is 

currently displayed.) Select Concurrent. 

 

The Concurrent option sets up the sound to play while the 
piece continues down the flowline to other icons that 
you’ll insert. The Wait Until Done option would finish 
playing the entire sound file before continuing down the 
flowline. 

 

6. Click OK to close the dialog box. 

Play Stop
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Link Media From a Library

 

Libraries are one of many Authorware features that increase 
your productivity, both during initial authoring and during 
the inevitable cycles of revision. Libraries can contain text, 
graphics, sounds, and movies. When you modify library 
content, you change it wherever it’s used in a piece and in 
other pieces that are linked to that library—instead of 
manually changing it every place it appears. Libraries can 
ensure consistent, up-to-date content among multiple pieces. 

In this section you’ll open a library, then bring two graphics 
from the library into your piece. 

 

1. Choose Open Library from the Libraries 

menu. In the Open Library dialog box, 

select the Merchnt.a3l library and 

click Open. 

 

A library window containing two icons appears on your 
screen. If you want, you can see what a library icon 
contains by selecting it and choosing Get Info from the 
Edit menu.  

 

2. Drag the Travel Background display icon 

from the library window to the flowline 

below the Travel Music sound icon. 

 

Notice that after you insert a library icon and click 
elsewhere in the design window, the icon title appears in 
italics. This indicates that the icon is linked to a library. 

 

3. Drag the Travel Logo display icon from the 

library window to the flowline below the 

Travel Background icon. 

 

Your flowline should look like the one below. You’ve 
inserted a sound and some graphics. Now let’s see how 
they work together.

 

4. Click the Run button in the toolbar to run 

your piece from the beginning. 

 

Authorware presents the content of each icon in order—
the main background, sound, and travel background and 
logo. 

 

5. Press Control-J (Windows) or Command-J 

(Macintosh) to return to the design 

window. 

6. Save your file by pressing Control-S 

(Windows) or Command-S (Macintosh). 

 

You can also choose Save from the File menu.
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Apply a Transition

 

Authorware 3.5 includes several transition Xtras—extensions 
to Authorware—that provide a huge selection of transitions, 
as well as precise control over the duration and smoothness of 
transitions. Use transitions to add visual impact and 
emphasize selected information. 

Here you’ll apply a transition to the first graphic in the piece. 

 

1. Double-click the Main Background 

display icon. 

 

Authorware opens the presentation window. 

 

2. Choose Transition from the 

Attributes menu. 

 

The Transition dialog box appears. Transitions appear in 
several categories, shown on the left. 

 

3. Select the Push Category on the left, then 

select the Push Down transition. Click 

Apply to preview the transition. 

 

Feel free to try out other transitions and experiment with 
the Duration and Smoothness settings. 

 

4. Click OK to close the dialog box and save 

your transition settings. 

 

5. Click the Run button in the toolbar to run 

the piece from the beginning, including 

the transition. 

6. Press Control-J (Windows) or Command-J 

(Macintosh) to return to the 

design window. 
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Animate a Graphic 

 

Moving objects in a piece can add impact, give feedback to 
users, and simulate the behavior of real-world objects. The 
motion icon in Authorware provides numerous options for 
how you move objects in your pieces. 

Here you’ll create a simple path animation for one graphic. 

 

1. Drag a motion icon from the icon palette to 

the flowline below the Travel Logo icon. 

Title the motion icon “Move Logo.” 

 

The motion icon is always placed after the object you want 
to move. 

 

2. Drag the start flag from the icon palette to 

the flowline below the Travel Music icon. 

 

The start and stop flags let you run a selected section of 
your file, such as the part you’re currently working on. 
When you insert a start flag and run the file from the flag, 
Authorware begins your piece with the first icon after 
the flag. 

Inserting a start flag in this case lets you focus on the next 
few steps without seeing the background graphic or 
hearing the music clip.

 

3. Click the Run from Flag button in the 

toolbar to run the piece from the start flag.

 

When you insert the start flag on the flowline, the Run 
button changes to the Run from Flag button. 

The Move Logo dialog box appears. This dialog box gives 
you options for setting up the animation.  

 

4. Drag the travel logo (which looks like a 

compass) to the center of the top line of 

the box in the background. 

 

Dragging the object tells Authorware where you want it to 
move when the file is run.  

 

5. In the dialog box, type .5 in the Rate field. 

 

The travel logo will move from its starting to ending 
position in .5 seconds. 

 

6. Click the Replay button to preview 

the motion. 

7. Click OK to close the dialog box. 
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8. Press Control-F (Windows) or Command-F 

(Macintosh) to run from the Start flag and 

see the animation. Then press Control-R 

(Windows) or Command-R (Macintosh) to 

run the entire piece from the beginning. 

 

Authorware includes keyboard shortcuts like these for 
many functions. 

 

9. Press Control-J (Windows) or Command-J 

(Macintosh) to return to the 

design window. 
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Create a Framework

 

The framework icon provides a structure that makes it easy to 
create navigation in your pieces. When you insert a framework 
icon and attach a series of other icons to it, you’ve built a 
complete paging structure without using any programming. 
You can customize the default structure to build intricate 
navigation schemes. 

In this section you’ll set up a framework and one page. 

 

1. Drag a framework icon from the icon 

palette to the flowline below the Move 

Logo motion icon. 

2. Drag a display icon from the icon palette to 

the right side of the framework icon.  

 

This is how you build a series of pages in a navigation 
structure. When you insert a display icon to the right of 
the framework icon, a connecting line appears between 
the two. (See illustration below.) The display icon 
becomes the first page in the navigation structure. As 
you’ll see later, the framework icon contains controls that 
let users move between the pages. 

 

3. Select the framework icon and title it 

“Locations.” Then press Enter (Windows) 

or Return (Macintosh) to select the display 

icon, and title it “Travel Intro.” 

 

This section of the flowline should now look like this:

 

4. Click the Run from Flag button in the 

toolbar. 

 

Authorware runs the file from the start flag and stops at 
the first empty icon, Travel Intro, to allow you to insert 
content. The toolbox appears.

Notice that there are now left and right arrow buttons and 
a Go To Merchants button on the screen. These buttons 
are part of the framework icon—a default navigation 
structure we’ve set up for the tutorial. You can easily 
modify the framework icon to build the navigation 
structure you need.
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Import an RTF File

 

Authorware lets you import text files from other applications 
into your piece, including files saved in rich text format (RTF). 
The benefit of using RTF text is that you can preserve the 
original formatting while editing the text in Authorware. 

When you import an RTF file, you can convert each page of 
text into a separate page in your navigation structure. You can 
also convert the text into scrolling text if you want. 

For this section we created an RTF file in a word processing 
program and divided it into four pages with page breaks.

 

1. Select the text tool in the toolbox (the 

letter “A”). Then in the presentation 

window, click about an inch to the right of 

the “L” in “TRAVEL” in the travel logo. 

 

A text width bar appears, indicating the starting point and 
width of the text field. But this default width is too 
great—it extends to the right of the background art. 
You’ll make it narrower in the next step. 

 

2. In the text width bar, click the adjustment 

handle on the right end (the square), and 

drag it to the left so it’s just inside the 

border on the artwork. 

 

You’ve defined the width of the text you’re about 
to import. 

 

3. Choose Import from the File menu. Select 

the Travel.rtf file and choose Open. 

 

The RTF Import dialog box appears. You won’t change the 
default settings.  

 

4. Click OK to close the RTF Import dialog box 

and import the text.

 

The text appears in the presentation window. And because 
the RTF file contained four page breaks, Authorware 
automatically adds three more display icons containing 
the other three pages of text.

 

5. Choose Modes from the Attributes menu. 

 

The Modes palette appears. The imported text is set to 
Opaque mode by default. But to make the text blend with 
the background art, you need to change its mode. 

 

6. In the Modes palette, select Transparent. 

 

The white background for the text disappears. You’ll need 
to do the same for each page of text if you want to make 
each transparent.
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7. Click the close box in the toolbox. Click the 

right and left arrow buttons to move back 

and forth between the pages of text. 

8. Press Control-J (Windows ) or Command-J 

(Macintosh) to return to the design 

window. 

9. Title the new page icons “Caribbean,” 

“Europe,” and “South America.” 

 

To give an icon a title, select it, then type the title. Press 
Enter (Windows) or Return (Macintosh) to move from 
one icon to the next. 

 

10. Press Control-S (Windows ) or Command-S 

(Macintosh) to save your file. 
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Import a Director Movie

 

Authorware makes it easy to integrate digital video into your 
pieces, including Macromedia Director, QuickTime, Video for 
Windows, and MPEG movies. 

Here you’ll import an interactive Macromedia Director movie 
after creating a map icon to contain it. 

 

1. Click the Caribbean icon, and then choose 

Group from the Edit menu.

 

This creates a map icon with the Caribbean display icon 
as its only content so far. Grouping icons into map icons 
streamlines the structure of your pieces, keeping related 
content together in one window. 

 

2. Double-click the Caribbean map icon to 

open it. 

 

A mini design window appears, containing the Caribbean 
display icon as the first icon on a flowline. 

 

3. Drag a digital movie icon from the icon 

palette to the flowline in the Caribbean 

window. Drop the icon after the Caribbean 

display icon. 

4. Title the movie icon “Caribbean Movie.” 

Then close the map window by clicking the 

close box. 

5. Click the Run from Flag button in the 

toolbar. When you get to the first screen in 

the framework, click the right arrow 

button on the screen. 

 

The Caribbean Movie dialog box opens, and then the Load 
Movie dialog box appears. Because you inserted a movie 
icon without adding content, Authorware stops to let you 
load the movie. 

 

6. Select the Dive.dir movie and click Open. 

In Windows, make sure the Use Movie 

Palette check box is unchecked.

 

The first frame of the Director movie appears in the 
presentation window, and information about it appears in 
the Caribbean Movie dialog box. 

 

7. Drag the Caribbean Movie dialog box off to 

one side. Then drag the movie to align it 

with the background frame (see 

illustration). 

8. Click OK in the dialog box. 

 

The movie is ready to run. Try clicking the four arrow 
buttons on the movie display to view the interactive 
Director movie. 

 

9. If necessary, resize and reposition the text 

to fit in the background area next to 

the movie. 

 

If the movie is crowding the text, double-click the text to 
select it. Move it by dragging it. Resize it by dragging one 
of its handles.
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Import Graphics

 

You can use bitmapped graphics in most standard formats in 
Authorware by importing the bitmap files. 

Here you’ll import three BMP files (Windows) or PICT files 
(Macintosh) into your piece. 

 

1. Close the toolbox if it’s open. Click the 

right arrow button to move to the next 

page. Then double-click the “Trek Across 

Europe” text that appears.

 

The toolbox for this display icon appears.

 

2. Choose Import from the File menu. Select 

the Europe.bmp (Windows) or Europe.pct 

(Macintosh) file and choose Open. 

 

The Europe graphic appears in the presentation window. 
To blend with the background art, however, it needs its 
mode changed.

 

3. Choose Matted from the Modes palette. 

 

Matted mode makes white pixels around the outside of a 
graphic transparent. 

 

4. If necessary, reposition the text and 

graphic to fit in the background area. 

(See below.) 

 

Move the graphic or text by clicking and dragging. Resize 
the text by dragging one of its handles.

 

5. Close the toolbox, and then click the right 

arrow button to move to the next page. 

Double-click the “South America” text that 

appears. 

 

Now you’ll import a graphic for this page. 

 

6. Repeat steps 2, 3, and 4 for this page, 

importing the Samerica.bmp file 

(Windows) or Samerica.pct file 

(Macintosh). 

7. Close the toolbox and click the right arrow 

button to move to the next page. Double-

click the “New Tours” text that appears. 

 

Again you’ll import a graphic. 
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8. Repeat steps 2, 3, and 4 for this page, 

importing the Travel.bmp file (Windows) or 

Travel.pct file (Macintosh). 

 

This screen is the introductory screen for the travel 
information section. 

You’ve now completed a four-page navigation structure 
that incorporates text, graphics, and an interactive 
Director movie. 

The next section about hypertext is optional.



 

Create Hypertext (optional) 24

 

Create Hypertext (optional)

 

Hypertext lets users click certain words to go to related text, 
images, or other content within a piece. In Authorware it’s easy 
to make any word or phrase clickable, visually highlight the 
“hot” words, and set up a variety of navigation methods that 
take users to new content. 

In this section, you’ll create hypertext links that let users learn 
more about a travel location that interests them—the 
Caribbean, Europe, or South America. 

 

1. In the Travel Intro display, choose the text 

tool in the toolbox (the letter “A”). Then 

double-click the word “Caribbean.”

 

(If the toolbox is not open, double-click the “New 
Tours” text.)

 

2. Choose Apply Styles from the Text menu.

 

 

 

Choosing Apply Styles opens a window listing the names 
of all text styles that have been created for this piece. We’ve 
created a style called Hypertext for you to use. (To create 
your own text styles, use the Define Styles command.)

The Hypertext style we created will automatically make 
the text blue and clickable. It will also change the cursor 
to a hand over Hypertext words. 

 

3. In the window, select Hypertext. 

 

Authorware displays the Navigate To dialog box, a key tool 
for building many different kinds of navigation.

 

4. In the list of icons on the right side of the 

dialog box, select the Caribbean icon. Then 

click OK. 

 

That’s how easy it is to set up the destination for a 
hypertext link. Now when users click the word 
“Caribbean,” Authorware will take them to the 
Caribbean page. 

 

5. Double-click the word “Europe.” In the 

window of text styles, select Hypertext. 

 

The Navigate To dialog box appears again. 

 

6. In the list of icons in the dialog box, select 

the Europe icon. Then click OK. 

 

Clicking “Europe” will now take users to the Europe page. 

 

7. Select the words “South America” and 

select Hypertext as the text style. 

8. In the list of icons in the dialog box, select 

the South America icon. Then click OK. 

 

You’ve created three hypertext links. Now you’ll try 
them out. 
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9. To start running the Authorware file from 

where you are, press Control-P (Windows) 

or Command-P (Macintosh). 

This command is like a toggle switch. When the piece is 
running, Control-P or Command-P means pause. When 
the piece is paused, the same command means proceed. 

10. Test out your hyperlinks by clicking 

“Caribbean.” 

The linked page appears.
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Create an Interaction with a Custom Button

Interactions are the heart of Authorware. They provide a way to 
actively engage users with your pieces. Authorware provides a 
wide range of interaction types, including pull-down menus, 
buttons, and text entry.

In this section you’ll create an interaction that leads to the 
section you just built. But first you’ll reorganize the icons on 
the flowline. 

1. Press Control-J (Windows) or Command-J 

(Macintosh) to jump to the design window. 

Then remove the start flag and return it to 

the icon palette by clicking its empty place 

on the palette. 

2. Select all the icons except the first, Main 

Background. 

To select several icons, hold down the Shift key while you 
click each of them. Or draw a selection rectangle around 
them by clicking to one side, then dragging to draw a 
rectangle. When selected, the icons become black. 

3. Choose Group from the Edit menu to 

create a map icon containing the selected 

icons. Then title the map icon “Travel.” 

Grouping a related set of icons helps to organize and 
modularize your file. 

4. Drag an interaction icon from the icon 

palette to the flowline below the Travel 

map icon. Title the interaction icon 

“Merchants.” 

You’re now going to create an interaction that will let 
users choose to see information about merchants. The 

first button you insert will take users to the Travel section 
that you’ve assembled and grouped into a map icon.  

5. Drag the Travel map icon from the main 

flowline to the right of the Merchants 

interaction icon. 

Authorware creates connecting lines showing the flow of 
the interaction and displays the Response Type dialog box. 
In this dialog box you select the kind of interaction you 
want to create for users. 

6. Click OK to accept the default choice of 

Button response type. 

In this case, users will click a button to see the travel 
information.

7. Double-click the response type symbol for 

the Travel icon (the miniature button—see 

illustration). 

Response type symbol
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The Button Options dialog box appears. Here’s where you 
select which button will be used and how Authorware will 
handle the content in the Travel icon—for example, 
when the content will be erased. 

8. In the Erase Feedback list box on the right 

side of the dialog box, choose Before 

Next Entry. 

This option will remove the contents of this map icon 
from the screen before users click another button. 

9. Under Button Type, click the image of the 

Travel button. 

The Button Library window appears. The Button Library 
contains the standard buttons provided by Authorware as 
well as any custom buttons you import. In this case, we’ve 
imported a custom button for you. 

10. Scroll up the list until you see the Travel 

button shown below. To select this button, 

click it, then click OK. 

11. Click OK to close the Button Options 

dialog box. 

12. Click the Run button in the toolbar. 

The piece runs from the beginning. Authorware 
encounters the interaction and waits for you to respond. 
For now, don’t worry about the position of the Travel 
button on the screen. You’ll fix that later. 
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13. Click the Travel button you inserted. 

Clicking the button directs the flow of the piece down the 
flowline of the Travel map icon. 

14. Press Control-J (Windows) or Command-J 

(Macintosh) to return to the design 

window. 

You’ve created an interaction using a custom button. Next 
you’ll add two more buttons and their content.



29 Authorware Working Model

Paste Models

Models are special Authorware files containing icon-and-
flowline structures that you can paste into a file. By letting you 
reuse structures you’ve built, models can save a lot of time 
during production. Models also let you create templates to 
share structures and content with other members of a team. 

In this section, you’ll paste two models to create two more 
choices for the interaction you just created. 

1. Choose Load Model from the Libraries 

menu. 

The Load Model dialog box appears. 

2. Select the Paris.mod file and click Open. 

The Paris model is now available for pasting into this file. 

3. Choose Load Model from the Libraries 

menu again. Then select the Pacsands.mod 

file and click Open. 

Now the Pacific Sands model is also available for pasting. 

4. Click to the right of the Travel icon.

A paste hand appears, indicating where pasted icons will 
appear on the flowline. 

5. Choose Paste Model from the Libraries 

menu, and select the Café Paris model. 

The map icon stored in this model file is pasted into your 
design window. This map icon contains its own set of 
icons with text, graphics, and sound content.

6. Choose Paste Model from the Libraries 

menu again, and select the Pacific Sands 

model. (If the paste hand is not displayed 

to the right of the Café Paris map icon, 

click to the right of this icon before pasting 

the model.) 

The design window now contains an interaction with 
three attached map icons. Because you set up the Travel 
icon as a button response type, the two icons to its right 
automatically acquire the same response type. (You could 
change this if you wanted.) 

We included custom buttons in the two models, so you 
don’t need to select buttons for them. 

The interaction you’ve created will provide the main 
structure for the piece. 

7. Press Control-S (Windows) or Command-S 

(Macintosh) to save the file. 
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Finish the Piece

Now you’ll tweak the alignment of the buttons and try out 
your complete piece. 

1. Press Control-R (Windows) or Command-R 

(Macintosh) to run the file. 

Authorware displays the Main Background graphic, then 
the Merchants interaction. The screen shows three buttons 
leading to the three map icons.  

2. Pause the application by pressing 

Control-P (Windows) or Command-P 

(Macintosh). Then drag the Travel button 

to align it with the Café Paris and Pacific 

Sands buttons (see below). 

3. When you’ve finished aligning the buttons, 

press Control-P (Windows) or Command-P 

(Macintosh) to run the piece from where 

you are. 

4. Click the Café Paris button. Click the arrow 

buttons to move between pages. Then 

click the Go To Merchants button to return 

to the interaction. 

5. Click the Travel button. If you created 

hypertext, try it out. Click the arrow 

buttons. Click Go To Merchants to return 

to the interaction. 

6. When you’re done trying out your piece, 

press Control-Q (Windows) or Command-Q 

(Macintosh) to close the file and exit 

Authorware. 

You’ve now created and edited a basic Authorware piece. 
With this much practice, you’re ready to start creating 
in Authorware.
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Experiment!

After completing the Try This! tutorial, you’ll probably want to see what else Authorware can do. A 
few suggestions:

• Make a copy of your Mystart file and experiment with it. 

Think of the Authorware design window as a slate on which you can quickly test out new 
ideas. Try out features and settings you didn’t use in the tutorial. 

• Examine and explore the Welcome piece. 

Run the Welcome file. Remember Control-P (Windows) or Command-P (Macintosh) for 
pausing and proceeding. Remember to use the start flag when you want to re-run one 
section over and over. 

• Run the Kiosk file. 

This file—the complete version of the piece that contains your tutorial file—is in the Kiosk 
folder on the CD. There’s a lot of Authorware know-how built into this piece, and a lot you 
can learn from exploring it. 

• Build your own piece. 

Why not? Start a new file and insert some icons. Create text and simple shapes with the 
toolbox, import graphics, even add sound. Keep in mind that there’s a size limit of 50 icons 
with the Working Model.



Authorware Working Model 32

Purchasing Authorware

We hope that the Working Model has clearly demonstrated the power and versatility that 
Authorware provides. Since its introduction Authorware has been the leading tool for creating 
interactive information applications. It remains the tool of choice for developing information-
intensive interactive multimedia. 

When you purchase Authorware, you receive both the authoring and runtime software, so you 
have everything you need to develop and deliver pieces to users. Also included are a range of 
drivers and file importers for integrating multimedia content, along with a selection of sample 
movies, sounds, and graphics you can use. 

Authorware is developed by Macromedia, the leader in multimedia, graphics, and online 
publishing tools. Macromedia does not charge royalties for the sale or distribution of applications 
created with Authorware. 

The commercial version of Authorware is available in the United States through value-added 
resellers (VARs). The educational version of Authorware is available in the United States through 
educational resellers. For the name of a VAR or educational reseller in your area, 
call (800) 288–4797.

• Macromedia, Inc. (US, Canada, Pacific and Latin America)
600 Townsend Street
San Francisco, CA 94103 
USA
Tel: (415) 252–2000
Fax: (415) 626–0554

• Macromedia Europe (includes Middle East and Africa)
Pyramid House
Easthampstead Road
Bracknell, Berkshire
RG12 1NS England UK
Tel: 44 1 344 45 8600
Fax: 44 1 344 45 8666
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• Macromedia Japan
2F Deer Plaza Akasaka
4-3-28 Akasaka
Minato-Ku
Tokyo 107 Japan
Tel: 81 3 5562 1980
Fax: 81 3 5562 1990

• Macromedia East Asia and Pacific
Tel: 61 3 9859 8325
Fax: 61 3 9859 4162
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